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1 HP OpenView GlancePlus Pak 
Release Notes
Announcements
The following information is for version HP-UX 10.20, 11.0 and 11i of HP 
OpenView GlancePlus Pak for the HP-UX Application Release in the Fall of 2001.

Refer to each product's Release Notes for system patch requirements. The Release 
Notes documents are in /opt/perf/ReleaseNotes/. Their filenames are:

• GlancePlus Release Notes : Glance 
• IT/Operations Special Edition Release Notes : Itose 
• HP OpenView Performance Agent (MeasureWare Agent) Release Notes: Mwa

Refer to each product's documentation for information about the functionality of 
each product. 

NOTE This document contains important information that is not included 
in other printed materials or in online help.
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HP OpenView GlancePlus Pak Release Notes
What’s New in This Version?
What’s New in This Version?
This release provides C.03.35.00 functionality. Please see the Release Notes for 
each product in /opt/perf/ReleaseNotes/.
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HP OpenView GlancePlus Pak Release Notes
Known Problems and Workarounds
Known Problems and Workarounds
The following requests remain open in this release. Refer to the Patches and Fixes 
in This Version section of this document for information about requests that have 
been fixed or addressed with patches.

To see the status of open requests, see “Online Documentation and Support” in the 
Version Information and File Placement Plan section of these Release Notes.

Request ID  Description

None.  

Troubleshooting Tips

If you have difficulties starting the ITO-SE Java user interface, run perfstat or 
opcagt -status to verify that the agent is running. Also, verify that you have 
entered the correct username and password.

If the ITO-SE agent does not start, verify that the installation was successful and that 
DCE is operational on the system.

After installation and removal of the GlancePlus product, run perfstat or 
opcagt -status to verify that the desired agents, HP OpenView Performance 
Agent (MeasureWare Agent) and HP OpenView Operations Agent, are running.
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HP OpenView GlancePlus Pak Release Notes
Compatibility Information and Installation Requirements
Compatibility Information and Installation 
Requirements
Before installing GlancePlus Pak, be sure that your system meets these minimum 
requirements.

• System Requirements 

— HP 9000 Series server or workstation 
— HP 9000 Series 700 or 800 
— 32 MB RAM, 64MB virtual memory 

The following is strongly recommended for running GlancePlus Pak ITO-SE 
Java user interface (gpitose): 

— 100 MHz or faster processor 
— 128 MB RAM or higher 

• Display Requirements

The following is required for running the GlancePlus Motif interface (gpm):

— HP X-terminal or X-workstation display, minimum of 1280 x 1024 
resolution and 8-color planes

The following is required for running the GlancePlus character mode interface 
(glance): 

— Terminals: HP 2392A, HP 700/44, HP 700/92, HP 700/94, VT100, or 
compatible terminal emulators, such as xterm, dtterm, or hpterm, under the 
X-Window system

The following is recommended for running GlancePlus Pak ITO-SE Java user 
interface (gpitose) in an X-terminal display:

— 26 MB RAM in an X-terminal display

• Disk Requirements — Total of 128 MB

— 50 MB in the /opt/perf/ directory for first-time installations of 
GlancePlus and MeasureWare Agent

— 33 MB in the /opt/OV/ directory for first-time installations of ITO-SE

— 42 MB in the /var/opt/perf/ directory for MeasureWare Server Agent

— 3 MB in the /var/opt/OV/ directory for ITO-SE
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HP OpenView GlancePlus Pak Release Notes
Compatibility Information and Installation Requirements
• Software Requirements

— HP-UX 11 and beyond with X-Windows libraries X11R5 or X11R6 and 
Motif libraries 2.1.

— Netscape 4.0 (or later) browser for viewing the ITO-SE and GlancePlus Pak 
online help files (HTML format).

Netscape FastTrack Server software is distributed as part of the core OS with 
HP-UX 11.0. This software includes Netscape Communicator, an HTML 
browser that you can use to view the ITO-SE online help. 

You can also download the Netscape browser at no charge from this Web 
site:

http://www.netscape.com/download

• Installation — Installation requirements as well as instructions for installation 
are documented in the GlancePlus Pak Installation Guide, located in the 
following places:

— Shipped with this product in: opt/perf/paperdocs/gpak/C/ as 
gpp-install.pdf

NOTE Documentation postscript (.ps) files are no longer shipped 
with this product.

— On the Web at:
http://ovweb.external.hp.com/lpe/doc_serv/

Select “GlancPlus Pak” in the Product list box and click Go.

• Required Operating System Patches:

— Symptom: When the home directory ($HOME) is automounted using 
AutoFS, some 11.0 systems do not respond to the gpitose command. 

— Solution: There are four possible workarounds. Choose one:

1. Install HP-UX patch PHNE_17101 or superseding patch. 

2. Set the HOME shell environment variable to a non-AutoFS-mounted 
directory before invoking gpitose.

3. Create a local HOME directory for the user.

4. Use automount instead of AutoFS for the user HOME directory.
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HP OpenView GlancePlus Pak Release Notes
Compatibility Information and Installation Requirements
— Symptom: In rare situations, the gpitose Java application core dumps. 

— Solution: Install HP-UX Motif/X11 patches:

HP-UX 10.20 PHSS_20861 (or a superseding patch)

HP-UX 11.0 and beyond PHSS_21493 (or a superseding patch)

— Symptom: Uninstalling an ITO agent removed the NIS entries in the /etc/
passwd and /etc/group files.

— Solution: Install HP-UX 11.0 and beyond PHCO_20679 (or a superseding 
patch).

• Performance Considerations when using the ITO-SE user interface:

The ITO-SE agent (which runs continuously) uses minimal system resources to 
gather system events and alarms and saves this data in a local message file. As 
with any Java application, when the ITO-SE interface is open, it requires 
significant system memory, display memory, and CPU to respond to user 
interactions. Newer systems (because of higher CPU clock speeds) show 
significantly improved performance.

 To alleviate some of the user interface loading, you can try one of these options:

— Because refreshing the interface can be the most significant recurring load, 
the first option is to increase the refresh interval. To do this, select 
Preferences on the Edit menu in the ITO-SE interface and change the refresh 
interval from 30 seconds to a minimum of 5 minutes. This minimizes the 
load of refreshing the interface.

— The second option is to set the View option (on the ITO-SE interface) to 
View -> Latest Messages. Do not set it to View -> All Messages.

— The third option is to reduce the message rate. Do this by suppressing 
unwanted messages in the template conditions (see online help for 
instructions on “Preventing Unwanted Messages”).

If the message rate is less than one message per minute, the load is much 
less. Note, however, that the number of messages received per interval does 
not impact performance as much as the refresh interval. 

• Related Documentation:

— Refer to the following documents for additional information about how to 
use GlancePlus Pak:
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HP OpenView GlancePlus Pak Release Notes
Compatibility Information and Installation Requirements
Access the following documents in /opt/perf/paperdocs/gpak/C:

— GlancePlus Pak Installation Guide—gpp-install.pdf 

— GlancePlus Pak Interoperability Guide—gpp-supplement.pdf

Access the following man pages by typing man <man_page>, such as 
man gpm:

— GlancePlus Pak: gpitose, gpseupdate 

— HP-UX Measurement Interface: arm, midaemon, perfstat, ttd, ttd.conf 

— For information on accessing the documentation on the web, see “Online 
Documentation and Support” in the Version Information and File Placement 
Plan section in these Release Notes.

— To print an ASCII file, type:

lp -d<printer_name> filename

For example:

lp -dros1234 metrics.txt
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HP OpenView GlancePlus Pak Release Notes
Patches and Fixes in This Version
Patches and Fixes in This Version
The following major requests have been fixed in this release.

Request ID  Description

8606184743   In some cases installation of the GlancePlus Pak changed 
OPC_MGMT_SERVER value in the opcinfo file to 
“unknown”. The GlancePlus Pak now correctly updates 
existing ITO-Enterprise agent software. The GlancePlus Pak 
Interoperability Guide explains how to configure the Pak to 
update existing ITO-Enterprise agents. 
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HP OpenView GlancePlus Pak Release Notes
Software Availability in Native Languages
Software Availability in Native Languages
ITO-SE is not localized in this release.
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Version Information and File Placement Plan
Version Information and File Placement Plan

Version Information

The following is a list of version strings for the major executable components of 
GlancePlus Pak:

Version Strings for HP-UX 10.20:

• ITO Operations Agent in the directory /opt/OV/bin/OpC/

ITO Agent A.05.57

• ITO-SE executable in the directory /opt/OV/bin/OpC/

itose A.05.57 05/29/01

• Glance Pak Integration file /opt/perf/newconfig/gpse.tar 

GlancePakInteg C.03.35.00 05/22/01 HP-UX 10.20
pm_gp.sh C.03.35.00 05/22/01 HP-UX 10.20
pak_pa.sh C.03.35.00 05/22/01 HP-UX 10.20
pak_anycmd.sh C.03.35.00 05/22/01 HP-UX 10.20
pak_cfgfile.sh C.03.35.00 05/22/01 HP-UX 10.20
pak_perfcmd.sh C.03.35.00 05/22/01 HP-UX 10.20
pak_chklic.sh C.03.35.00 05/22/01 HP-UX 10.20
pak_ds_chk.sh C.03.35.00 05/22/01 HP-UX 10.20

Version Strings for HP-UX 11.0 and Beyond:

• ITO Operations Agent in the directory /opt/OV/bin/OpC/

ITO Agent A.05.57

• ITO-SE executable in the directory /opt/OV/bin/OpC/

itose A.05.57 05/30/01
14



HP OpenView GlancePlus Pak Release Notes
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• Glance Pak Integration file /opt/perf/newconfig/gpse.tar 

GlancePakInteg C.03.35.00 05/22/01 HP-UX 11
pm_gp.sh C.03.35.00 05/22/01 HP-UX 11
pak_pa.sh C.03.35.00 05/22/01 HP-UX 11
pak_anycmd.sh C.03.35.00 05/22/01 HP-UX 11
pak_cfgfile.sh C.03.35.00 05/22/01 HP-UX 11
pak_perfcmd.sh C.03.35.00 05/22/01 HP-UX 11
pak_chklic.sh C.03.35.00 05/22/01 HP-UX 11
pak_ds_chk.sh C.03.35.00 05/22/01 HP-UX 11

For a summary of version strings for installed performance tools, enter the 
command: 

/opt/perf/bin/perfstat -v

File Placement Plan

The following is a list of directory locations for product files. 

For a list of all files in the product, enter the command:

/usr/sbin/swlist -l file <bundle_name>

<bundle_name> = GlancePlus Pak bundle name on your system

Release Notes: 

/opt/perf/ReleaseNotes/Glancepak

Executables including UI programs, daemons, and scripts: 

/opt/perf/bin/
/opt/OV/bin/OpC/
/var/opt/OV/bin/OpC/GlancePak/
/var/opt/OV/conf/OpC/GlancePak/

Man pages: 

/opt/perf/man/man1/

Printable documents: 

/opt/perf/paperdocs/gpak/C/

Default configuration and template files: 

/opt/perf/newconfig/
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Replaced configuration and status files: 

/var/opt/perf/oldconfig/GPsetar/

Online help files: 

/opt/OV/www/htdocs/itose/help/ 
/opt/OV/www/htdocs/itose/help/glancepluspak/
/opt/OV/www/htdocs/itose/help/glancepluspak/images/

Online Documentation and Support

 Go to the HP OpenView eCare web site to access interactive technical support 
tools. The same information and tools used by HP OpenView phone support experts 
are now available at:

 http://support.openview.hp.com/

•  To view the status of customer requests:

1. Go to the “Troubleshooting” window and select “search knowledge base for 
documents, known problems, & patches.”

2. In the “Retrieve Document by ID Number” window, enter the document ID 
number and click View Document.

You can also search for other documents in the “Search for Documents” 
window on this page.

You can also search for 

•  To view these or archived Release Notes and other documentation:

1.  Go to the “Using Products” window and select “user manuals.” This takes 
you to the “HP OpenView manuals” web site: 

http://ovweb.external.hp.com/lpe/doc_serv/

2. Select “GlancPlus Pak” in the Product list box and click Go.
3. To see archived versions of the GlancePlus Pak documentation, select 

“Older” in the Release list box and then click Go.
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